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Overview:

The DNA Test Optimizer (Generate Test Objects) application allows the Financial Institution
to retrieve test data quickly and dynamically for pre-defined conditions based on Account,
Person, and Organization criteria, and utilize this test data when validating new releases and
system updates and incumbent functionality. This allows the User to easily find test data to
use instead of having to track down test data from outside query tools or reports, and to not
have to use the same testing data sets every time.

Key Benefits:
The DNA Test Optimizer application allows the Financial Institution to streamline the retrieval
and overall process of their test data needed for release and system regression testing.

Benefits include:

e Queries are User-defined, and are performed within DNA instead of using an outside
guery tool.

e Set up of pre-defined SQL Statements to retrieve test numbers for Persons,
Organizations, Deposit Accounts or Loan Accounts based on specific conditions that
can be run at any time.

e Storage of SQL queries in clear text format.

e Dynamic query functionality in that a query will retrieve current real-time data for that
database e.g. searching for a loan account in a certain product that is past due by
more than x days.

e Ability to create an evolving library of standard SQL Statements to retrieve test
numbers based on specific conditions.

e Portability that allows an export file of the SQL Statements to be imported into another
database, essentially allowing the library to be copied if desired.

e On-screen choice of the maximum number of records to retrieve.

e Catalog and filtering ability to organize SQL Statements into groups for easier on-
screen access.

Processing:

The DNA Test Optimizer application is designed to allow Financial Institutions to retrieve test
data quickly based on pre-defined SQL Statements. The DNA Test Optimizer application
includes the Generate Test Objects and the Generate Test Objects — SQL Test screens. The
Financial Institution would add the SQL Statements on the Generate Test Objects — SQL
Test screen and then the User can run the SQL Statements on the Generate Test Objects
screen to get the test data.

The existing ‘SQL — SQL Maintenance’ authorization item must be assigned and have
appropriate permissions established in order to access and utilize the Generate Test Objects
— SQL Test and Generate Test Objects screens.
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This application is designed to run SQL Statements that return Person numbers,
Organization numbers, Deposit Account numbers or Loan Account numbers. The SQL
Statements used for this application will be maintained on the Generate Test Objects — SQL
Test screen which is accessed via Services > System > Printing Operations > Generate Test
Objects — SQL Test > Create/Edit SQL Statement.

Note: If the SQL Statement is written to return a number in the first column and a name or
description in the second column, it can be utilized with this application.

To create a new SQL Statement to be used to retrieve the test data on the Generate Test
Objects screen, the following would occur:

1. Navigate to Services > System > Printing Operations > Generate Test Objects — SQL
Test to access the Generate Test Objects — SQL Test screen.

g Tickler ] Table Maintenance ]
2| Generate Test Objects - SQL Test
|7 | saQL Statement Details
g‘ Create SQL  EditS0L  Export  Import  Refresh
| Humber Hame Description Category =
é 1| TAAS 100001 Active Savings Accounts 200 balance No Restrictions Deposit Account
2 | TAAS 100002 List of Checking Accounts Other
3 | TAAS 10 Persons Without Restrictions Other
4 [ TAAS 1058 Cash Count Opticn Value & Denominations Other |
5 | TAAS 1002 Active Savings Account Without Restriction Other
6 | TAAS 1062 Active MTG Accts Note Bal » 0 and IntMethCd = SMP & LIAA Other
7 | TAAS 1063 Valid Active CNS Term Fixed Rate Products Other
& | TAAS 1064 Create New Loan Account Workflow Linked Screens Other
9 | TAAS 1067 Valid Active CNS Deposit Collateral Products Other
10 | TAAS 1089 Valid Active TD with Note Bal > 2500 TRF Pers and no Deposi.. | Other
11| TAAS 1021 Active CNS Accts with Note Bal = 0 no Escrow Bal Other
12 | TAAS 1003 Active Savings Account with 200 balance and without restrict | Other
13 | TAAS 1004 Active Checking Account Without Restriction Other
14 | TAAS 1005 Active General Ledger Account With Title Other
15 | TAAS 1006 Approved Pazsbook SAV Acct Without Restriction Other
16 | TAAS 1007 Active Dep Acct Without Restriction and Title Other
17 | TAAS 1008 Active Dep Acct with Single Owner Other
18 | TAAS 1009 Active Dep Acct with Joint OR Owner Other
19 | TAAS 1010 Dermant Deposit Account Without Restriction Other
20 | TAAS 1011 Active Deposit Account Without Restriction Other
21 | TAAS 1012 Active MTG Accts Unapplied Balance Greater Than Zero Other
22 | TAAS 1013 Active MTG Accts Escrow Balance Greater Than Zero Other
23 | TAAS 1014 Approved Saving Acct Without Passbook and Restriction Other
24 | TAAS 1015 Active Dep Acct with Without Passbook and Parent Txn Other
25 | TAAS 1016 Active MTG Accts with Note Balance Greater Than Zero Other
26 | TAAS 1017 Active CK Account with 1000 bal and without restriction Other
27 | TAAS 1018 Active Savings Account with 1000 balance without restrict Other
T PRODUCTION [Last login: 6/25/2019 4:10:53 AM on DNACREATOR]
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2. Click the “Create SQL” sub menu to bring up the Create SQL Statement screen.

Tickler | PrintGroups |  Table Maintenance © |

3

2] Create SQL Statement

7 | Create SQL Statement
SQL Mumber I Commen ts
5QLMName  »
Description »I
Category »I<55\ectt;ategnry> j

= Glose {” Glear (" Review | Process

3. Enter the following information:

a. SQL Name: This is a user defined value. This name will show up in a dropdown
list under the Category when using the application, so it is recommended to
define a naming convention that makes it easy for the User to find and use their
desired statement. Example: TAAS 1001 or SQL 200

b. Description: This is a user defined value. Example: Active Savings Accounts
with User Field Value

c. Category: This is a system defined value. Select from the dropdown list values
and assign a Category that best fits the SQL Statement’s area or test group.

d. Comments: This is a user defined value. This will contain a more defined
description of what the SQL Statement will return in the Search Results.

e. Copy/Paste a SQL Statement or add a SQL Statement in the large box. The
SQL Statements must return only an Object Number and Object Name as those
are the only two values to display on the Generate Test Objects screen. An
example would be a SQL Statement that returns a Person Number in Column 1,
and the Person Name in Column 2.
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Tickler ] Print Groups ] Table Maintenance ]

Create SQL Statement
Create SQAL Statement

SOL Mumber Comments Query to find persons with ne warning flags and a home

phone number

SQL Mame xIPersun Home Phone

djoH | seguone | seaimieg

Description »IPersUns ‘With Home Phone Numbers Mo Reslnc‘tiuns‘

Category mIPersun j

select distinct p.persnbr,(p.lastname I°, ' I p.firstname) "Entity Name” from pers p ;I
left outer jein perswrn pw on p.persnbr=pw.persnbr

left outer join persempl pe on p.persnbr=pe.persnbr

left outer join (select persnbr,phonentr from persphone where phoneusecd="PER') pp on pp.persnbr=p.persnbr

where p.validyn="" and p.datebirth iz not null and p.datedeath is null

and pw.persnbr is null and pe.persnbr is null

and pp.persnbr is not null

order by 1

=
Expand View

4. Click Process. DNA will assign the SQL Number.

Note: The SQL Statements are stored in the SQLTEST EXTN table. Only SQL
statements that are maintained on the Generate Test Objects — SQL Test screen and
added to the SQLTEST EXTN table are available on the Generate Test Objects
screen to retrieve test data.

Important: the SQL Statements are limited to overall character sizes of 2000
characters.

Once the SQL Statements have been created on the Generate Test Objects — SQL Test
screen, the User can then access the Generate Test Objects screen and retrieve their test
data numbers to begin their testing. The User would follow the steps below to retrieve their
test data.
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1. The User would access the Generate Test Objects screen via Services > Batch > View
> Generate Test Objects.

Tickler ] Batch Processing Maintenance ]

Generate Test Objects

Search Criteria

Search Criteria

djpy l saquone | saa1U0g

SQL Category n|<5eled Category= j Mumber of Records to Display nl 50
SQL MName J&I j S0L Description
SQL Comment ;I
[
Query | | Clear |
Search Results
Test Object Humber Test Object Name

Close

2. The User would then select from the SQL Category, which would then present a
dropdown list of SQL Name queries to be selected from via the SQL Name field. The
User may also elect to use the system default of a maximum of 50 records to display,
or change this number per application allowances (see Screen Appearance for more
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details on allowed values and recommendations).

Tickler ] Batch Processing Maintenance ]

Generate Test Objects

Search Criteria

djoy | sequoaey | saaiuag

Search Criteria

SQL Category  »|<Select Category>
EeR T T - Cclect Category=
2 Deposit Account
S0L Comment Loan Account ;I
GL Account
Person =
Organization _I
Channels

Number of Records to Display 20| 50

SQL Description I

Search Results

Test Object Number Test Object Hame

3. When the desired SQL Name is selected, the User would then click the Query button
to return the test data for the SQL Name entered. The SQL Description and SQL
Comments (if applicable) will also display on the screen.
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g Tickler ] Batch Processing Maintenance ]
& -
g | Generate Test Objects
-
=
=
]
% Search Criteria
=z
£ Search Criteria
SQL Category leepUs'ﬂ Account j Mumber of Records to Display  » 50
SQLName  ;[7aas 100001 = SQLDescription  [active Savings Accounts 200 balance No Restricti
SQL Comment Alist of Active Savings Accounts with 200 or greater balance and without restrictions on either the Account or Tax Owner. ;I
E
Search Results
Test Object Humber Test Object Hame
310362772 Styer, Quincy
350361246 Styer, Quincy
350550566 Schrader, Omar
700003114 Termini, Maxwel
700004675 Shook, Matt
700017412 Schrawder, Sal
700025945 Brinkman, Jennifer
700031991 Brinkman, Terry

Note: If the SQL Statement that was written does not return a value when the User enters the
SQL Name and clicks the Query button, the screen will display the SQL Description, SQL
Comments (if applicable) and will show no data in the Search Results grid.

If the Financial Institution utilizes multiple databases for testing and/or wants to add the same
SQL Statements from their test database to their production database, they can utilize the
Export and Import functions of this application.

To export the SQL Statements from one database and import to another, the User would
follow the steps below:
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1. Navigate to Services > System > Printing Operations > Generate Test Objects — SQL
Test to access the Generate Test Objects — SQL Test screen.

g Tickler ] Table Maintenance ]
2| Generate Test Objects - SQL Test
2| SQL Statement Details
s‘ Create SQL  EditSQL  Export Import Refresh
= Humber Name Description Category =1
é 1 | TRAS 100001 Active Savings Accounts 200 balance No Restrictions Deposit Account
2 | TAAS 100002 List of Checking Accounts Other
3 | TAAS 1001 Persons Without Restrictions QOther
4 | TAAS 1058 Cash Count Option Value & Denominations Other ||
5 | TAAS 1002 Active Savings Account Without Restriction QOther
6§ | TAAS 1082 Active MTG Accts Mote Bal = 0 and IntMethCd = SMP & LI&A .. | Other
T | TAAS 1083 Valid Active CNS Term Fixed Rate Products QOther
8 | TAAS 1064 Create New Loan Account Workflow Linked Screens Other
g | TARAS 1087 Valid Active CNS Deposit Collateral Products Other
10 | TAAS 1069 Valid Active TD with Note Bal = 2500 TRF Pers and no Deposi... | Other
1| TRAS 1021 Active CNS Accts with Note Bal = 0 no Escrow Bal Other
12 | TAAS 1003 Active Savings Account with 200 balance and without restrict | Other
13 | TAAS 1004 Active Checking Account Without Restriction Other
14 | TAAS 1005 Active General Ledger Account With Title Other
15 | TAAS 1006 Approved Passbook 3AV Acct Without Restriction Other
16 | TAAS 1007 Active Dep Acct Without Restriction and Title Other
17 | TRAS 1008 Active Dep Acct with Single Owner Other
18 | TRAS 1009 Active Dep Acct with Joint OR Owner Other
19 | TAAS 1010 Dormant Deposit Account Without Restriction Other
20 | TRAS 10T Active Deposit Account Without Restriction Other
21 | TRAS 1012 Active MTG Accts Unapplied Balance Greater Than Zero Other
22 | TRAS 1013 Active MTG Accts Escrow Balance Greater Than Zero Other
23 | TAAS 1014 Approved Saving Acct Without Passbook and Restriction Other
24 | TRAS 1015 Active Dep Acct with Without Passbook and Parent Txn Other
25 | TAAS 1016 Active MTG Accts with Note Balance Greater Than Zero Other
26 | TAAS 1017 Active CK Account with 1000 bal and without restriction Other
27 | TAAS 118 Active Savings Account with 1000 balance without restrict Other

2. Select the Export menu item to display the Generate Test Objects — SQL Export
screen.

Generate Test Objects - SQL Export
Export File

File Path  » | Browse |

3. Click the Browse button to navigate to the location where the export file will be saved
and to name the file. Note: File Name for this example is SQL Statements Export.
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[& CORE - Anywhere Financial (TEST SYSTEM)
Logout

institution ~ Business Tables ~ SystemTables GL Printing Operations ~ Productand Pricing Manage MyForms  System

fiserv.

Tickler ©'|  Table Maintenance © |
E' Generate Test Objects - SQL Export
T | ExportFile

File Path  » Browse
X
5

[ o o()v| .~ Computer + Local Disk (C:) = GTO Testing ~ [& e croTesting

Organize +  New folder

¢ Favorites ;I Name |Dace modified | Type |5|ze
2

M Desktop No items match your search,
8 Downloads
=] Recent Places

G Lbraries
[ Documents
o Music
[ Pictures

B videos

% computer
&2, Local Disk (€3
[P (1 |

a
File name: [ SQL Statements Export =
|

Save as type: [Text fies (*.txt)

4. Click the Save button to save the file name and location and return the values to the

File Path field.

Generate Test Objects - SQL Export
Export File

File Path »IC:\G’TO Testing\SQL Statements Export.bet | Browse |

5. Click the Process button to create the export file. The success message is displayed.

Generate Test Objects - SQL Export
Export File

File Path »IC:\GTCI Testing\SQL Statements Export bt Browse

Close

j ) 3SOLStatements are exported

6. Click the OK button on the “X SQL Statements are exported” message, where X

represents the number of SQL Statements that will be exported.
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7. Verify the SQL Statements Export file was created in the designated file path.

I
G‘ ) ~ Computer + Local Disk (C:) ~ GTO Testing v K23 | Search GTO Testing e

Open v Pt New folder = - 0@

Name = ]oaumodﬁed ]Tvpe Isae I

Export Test Fle. txt 2/3/2019 9:51 AM Text Cocument 48

Import File from Scratch, txt

Text Document

8. Access the database that the SQL Statements are to be imported and navigate to the
Generate Test Objects — SQL Test screen.

Generate Test Objects - SQL Test
SQL Statement Details
Create SQL 4 E t  import  Refresh
Numiber Hame Description
Chuss ] Delate

9. Select the Import menu to display the Generate Test Objects — SQL Import screen.

Generate Test Objects - SQL Import
Import File
File Path = | Browse |

10. Click the Browse button to locate the previously exported file is located.
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Generate Test Objects - SQL Import
Import File
File Path  » |_Browse |
Import File ﬂ
(‘_) (_) ‘ + Computer ~ Local Disk (C:) ~ GTO Testing - lmj I Search GTO Testing Eﬂ
Organize *  New folder B= - [ ‘E-‘
¢ Favorites Mame - Date modified Type I Size | |
B Desktop || Export Test File. bt 2/3/2019 9:51 AM Text Document 4KB
8 Downloads I 1mport File from Seratch, bt 2/4/2019 11:05AM  Text Document 1KB
= Recent Pl
L RecentPlaces | Issue 35 - First Export. txt 3/21/2018 3:51PM  Text Document 6B
o | Message Test File.txt 2/3/2019 2:36 PM Text Document 3KB
w4l Libraries
3 Documents || Semicolon Export Import Test. txt 2/5/2018 2:49 PM Text Document 2KB
& Music B 50 statements Export. bt 2/5/2019 9:19 AM Text Document B
gﬂ New Library | Test Case 3.40.txt 2/4/2019 12:53 FM Text Document 4KB
=] Pictures | TestFile for UM, txt 2/7/2019 10:18AM  Text Document IKB
8 videos | Testing. tct 2/4/2015 1:43 PM Text Document 4KB
18 Computer
£, Local pisk (c:)
(—a Local Disk (G:)
&.i.l Network
File name: [SQL Statements Export.txt j ITEXt files (“tdt) j
Open I Cancel |
4

Note: Only an export file generated on the Generate Test Objects — SQL Test screen

can be used for the Import process.

11. Click the Open button to save the file name and location to the File Path field on the

Generate Test Objects — SQL Import screen.

Generate Test Objects - SQL Import
Import File

File Path  »|CAGTO Testing\SOL Statements Export.bet

Browse

Close

12. Click the Process button. The success message is displayed.

Generate Test Objects - SQL Import
Import File

File Path  »[CAGTO Testing\SQL Statements Export bt | Browse ]

\i‘) 3 S0L Statements are added

y

13.Click OK to the “3 SQL Statements are added” message and return to the screen.

DNA Test Optimizer
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14. Click the close button to close the Generate Test Objects — SQL Import screen and
return to the Generate Test Objects — SQL Test screen.

Generate Test Objects - SAL Test
SQL Statement Details
Create SQU t 5Q sport  Import  Refresh
Humber Name Description

oo ] ]

15. Select the Refresh menu to refresh the screen and display the SQL Statements that
were added.

Application Messages:
If the User attempts to change the default value of 50 to a number greater than 1000 in the

‘Number of Records to Display’ on the ‘Generate Test Objects’ screen, the following message
will be displayed “The value entered must be between 1 and 1000.

if Records to Display Z@I 1M1

[

@ The value entered must be between 1 and 1000.

If the User enters a SQL Name that does not have an exact match to a SQL Statement in the
SQLTEST EXTN table, the following message will be displayed “Search criteria did not return
an exact match. Please adjust your search criteria and try again.”
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-

y Search criteria did not return an exact match. Please adjust your search criteria and try
again.

If the User enters a SQL Name and the SQL Statement for that SQL Name does not return a
valid number and name combination in the results, the following message will be displayed
“The SQL Statement mustreturn an Object Number and Object Name. Please update the
SQL Statement.”

i The SQL Statement must return an Object Mumber and Object Mame. Please update the
\\4) SCL Statement.

Note: The SQL Statement mustreturn a Number in the first column and a Name or
Description in the second column, such as a Person Number & Person Name or Account
Number and Account Owner Name.

If the User selects a record and clicks the Delete button on the Generate Test Objects — SQL
Test screen, the following message is displayed “Hit OK to confirm deletion of SQL
Statement, CANCEL to exit.”

1 ) Hit OK to confirm deletion of SCGL Statement, CANCEL to exit

| 0K || Cancel |

Note: If the User selects OK, the SQL Statement is deleted and removed from the SQLTEST
EXTN table. If the User selects Cancel, the action is canceled, and they are returned to the
Generate Test Objects — SQL Test screen.

When creating an export file on the Generate Test Object — SQL Export screen, once the
Process button is selected and the file is exported successfully, the following message is
displayed “<Number> SQL Statements are exported.” The <Number> dynamically displays
the actual number of SQL Statements exported from the SQLTEST EXTN table.

-
-

1 ) 3 S0L Statements are exported

-

When importing a file on the Generate Test Object — SQL Import screen with SQL
Statements that already exist, once the Process button is selected and the file is imported
successfully, the following message is displayed “<Number> SQL Statements are updated”.
The <Number> dynamically displays the actual number of SQL Statements updated from the
import file.
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-

\!‘) 6 SCL Statements are updated

When importing a file on the Generate Test Object — SQL Import screen that contains both
existing and new SQL Statements, once the Process button is selected and the file is
imported successfully, the following message is displayed “<Number> SQL Statements is
added <Number> SQL Statements are updated.” The <Number> represents the actual
number of SQL Statements updated/added from the import file.

1 ) 1 S0 Statement is added 2 SQL Statements are updated

When importing a file on the Generate Test Object — SQL Import screen with new SQL
Statements, once the Process button is selected and the file is imported successfully, the
following message is displayed “<Number> SQL Statements are added.” The <Number>
dynamically displays the actual number of SQL Statements updated from the import file.

~
L]

1 ) 3 SQL Statements are added

When attempting to query the test results on the Generate Test Objects screen for a SQL
Statement that was created is invalid and/or incorrectly written, when the Query button is
selected, an Oracle exception message is displayed.

An oracle exception has occurred. The details are:

Oracle DataAccess Client OracleException ORA-00942: table or view does not exist  at
Oracle DataAccess Client OracleException. HandleErrorHelper{Int32 errCode,
OracleConnection conn, IntPtr opsErrCty, OpoSqlvalCix* pOpoSqglvalCt, Object src,
String procedure, Boolean bCheck, Int32 isRecoverable)
at Oracle.DataAccess.Client.OracleException HandleError(Int322 errCode,
CracleConnection conn, String procedure, IntPtr opsErrCtx, OpoSglValCtx*
pOpoSqglValCtx, Object src, Boolean bCheck)
at Oracle DataAccess.Client.OracleCommand ExecuteReader(Boolean reguery,
BooleanfillReguest, CommandBehavior behavior)
at Oracle DataAccess.Client.OracleDataAdapter Fill{DataSet dataSet, Int32 startRecord,
Int32 maxRecords, String srcTable, IDbCommand command, CommandBehavior

behavior)
at System.Data.Common.DbDataAdapter Fill(DataSet dataSet)
at GenTestObjects. SqlProvider. GenTestDataCsibankDataAccess. GetResultList(String
sqglStatement, String numGCfRec)

When attempting to Import a file that was not generated from the Export function within the
Generate Test Objects application, the following message is displayed “Incorrect File
Importing”.
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Parameters:
N/A

Variables:
N/A

Tables:

@ Incarrect File Imparting

The SQLTEST EXTN table stores the SQL Statements for the Generate Test Objects
application in text format.

Note: When adding a new SQL Statement, the SQLNBR is assigned by adding 1 to the
maximum number in the table.

Field Name | Field Description | Primary | Nullable | Data Type | Length | Default
Key YN | YN

SQLNBR SQL Number Yes No NUMBER 22,0

SQLNAME SQL Name No No VARCHAR2 | 255

SQLDESC SQL Description No Yes VARCHAR2 | 255

SQLCOMME | SQL Comment No Yes VARCHAR2 | 255

NT

SQLTEXT SQL Statement No No VARCHAR2 | 2000

SQLCATEGO | SQL Category No No VARCHAR2 | 255

RY

DATELASTM | Date Last Maintained | No Yes DATE SYSDATE

AINT

Scheduling and re-run

N/A

Reports:

N/A

File Layouts:

DNA Test Optimizer 17

08222019




DNA Test Optimizer Fiserv

The Generate Test Objects application creates an export file of the SQL Statements stored in
the SQLTEST EXTN table. This export file is then used to import the SQL Statements into
another database. The export/import function can only be used within the Generate Test
Objects application and the files cannot be manually created.

The SQL Statement information is stored as “text” in the SQLTEST EXTN table.
When the export file is created, the fields are separated by the “” symbol. If the SQL

Statement was created with multiple lines, each line is separated by “>>>"to represent the
carriage return when the file is extracted.

_, —_—_—m—mmm—————————
Il Test File for UM.txt - Hotepad I (= 5]
¢
erson s warni N ir:

Typed, wiaccrrypdescorfron mimiaccrryp;
salect * from acct>>>where currmiacctiyped = 6700
XR';

e Fow.

ne o
cd = CFI

Field Listings:
Field Format Description
SQLNAME Text SQL Name
SQLDESC Text SQL Description
SQLCOMMENT Text SQL Comments
SQLCATEGORY Text SQL Category
SOQLTEXT Text SQL Statement

Screens:

Navigation:

Services > Batch > View > Generate Test Objects

Screen Appearance (Generate Test Objects):

DNA Test Optimizer 18
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g Tickler W Batch Processing Maintenance ]
g Generate Test Objects
% Search Criteria
é Search Criteria
SQL Category xI<SeIec‘t Category= j Mumber of Records to Display »liEU
SQL Name jg| j SQL Description |
SQL Comment ;I
[
Search Results
Field Listing:
Field | Description
Search Criteria
SQL Category System Defined, Dropdown List of Values. The current valid values are:
Deposit Account
Loan Account
GL Account
Person
Organization
Channels
Other
SQL Name The SQL Name of the SQL Statement.
Number of Enabled and displays an initial value of 50. This value controls the maximum
Records to Display | number of Search Results to be displayed.
The User may change this number on the screen and must use a minimum value
of 1, with a maximum value of 1000.
Note: itis not recommended to change this value from 50 unless a slightly higher
number is needed (e.g. 75 records), as higher values will result in decreased
performance.
DNA Test Optimizer 19
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Field Description

SQL Description Disabled Field. Display the SQL Description based on the SQL Name entered
when the Query button is selected.

SQL Comments Disabled Field. Display the SQL Comments based on the SQL Name entered
when the Query button is selected.
If the SQL Comments for the SQL Statement selected is null, then display blank.

Query <button> Once the User has entered the SQL Name and select the Query button, the

screen will display the SQL Description, SQL Comments (if applicable) and the
Search Results.

If the User has entered a SQL Name that does not have a match in the SQLTEST
EXTN table, then the following message is displayed “Search criteriadid not
return an exact match. Please adjust your search criteria and try again.”

If the SQL Statement assigned to the SQL Name entered is not a valid SQL
Statement for this application, the following message is displayed “The SQL
Statement must return an Object Number and Object Name. Please update the
SQL Statement. ©

Note: Valid SQL Statements for this application must return a Number in the first
column and a Name or Description in the second column.

Clear <button>

If the Clear button is selected, all search criteria is cleared, and the User will
remain on the Search Criteria section of the Generate Test Objects screen.

Search Results

Test Object
Number

Displays up to X records based on the SQL Name entered in the Search Criteria,
where X is the value fromthe Number of Records to Display field (defined as Y
for the example below). Default value is 50. The maximum number of records
allowed to display is 1000.

If there are less than X records found, only those numbers will display. If there
are more than X records found, only the first Y number of records will display
based on the SQL Statement selected.

Test Object Name

Display the Name or Description based on the SQL Name entered in the Search
Criteria.

Based on the SQL Results, the following would be applicable:

For Person Number, display the Person Name

For Organization, display the Organization Name

For Deposit Account Number, display the Tax Reported For Owner Name
For Loan Account Number, display the Tax Reported For Owner Name
For user defined SQL’s, display a number in the Test Object Number and
display a name and/or description in the Test Object Name. Example:

Test Object Number is 1 and the Description is Check — Existing Customer
— No Hold.

Close <button>

If the Close button is selected, the screen is closed.

DNA Test Optimizer
08222019

20




DNA Test Optimizer

Fiserv

Navigation:

Services > System > Printing Operations > Generate Test Objects — SQL Test

Screen Appearance (Generate Test Objects - SQL Test):

g Tickler ] Table Maintenance ]
2| Generate Test Objects - SAL Test
I'| SQAL Statement Details
5‘ Create SQL  EditSQL  Export Import Refresh
“ Number Hame Description Category =
g 1 | TAAS 100001 Active Savings Accounts 200 balance No Restrictions Deposit Account
2 | TAAS 100002 List of Checking Accounts Other
3 | TAAS 1001 Persons Without Restrictions Other
4 | TAAS 1058 Cash Count Option Value & Denominations Other ||
5 | TAAS 1002 Active Savings Account Witheut Restriction Other
6 | TAAS 1062 Active MTG Accts Note Bal > 0 and IntMethCd = SMP & LIAA ... | Other
T | TAAS 1063 Valid Active CNS Term Fixed Rate Products Other
3 | TAAS 1084 Create New Loan Account Workflow Linked Screens Other
9 | TAAS 1087 Valid Active CNS Deposit Collateral Products Other
10 | TAAS 1069 Valid Active TD with Note Bal = 2500 TRF Pers and no Deposi.. | Other
11 | TAAS 1021 Active CNS Accts with Note Bal = 0 no Escrow Bal Other
12 | TAAS 1003 Active Savings Account with 200 balance and without restrict | Other
13 | TAAS 1004 Active Checking Account Without Restriction Other
14 | TAAS 1005 Active General Ledger Account With Title Other
15 | TAAS 1006 Approved Passbook SAV Acct Without Restriction Other
16 | TAAS 1007 Active Dep Acct Without Restriction and Title Other
17 | TAAS 1008 Active Dep Acct with Single Owner Other
18 | TAAS 1009 Active Dep Acct with Joint OR Owner Other
18 | TAAS 1010 Dormant Deposit Account Without Restriction Other
20 | TAAS 101 Active Deposit Account Without Restriction Other
21 | TAAS 1012 Active MTG Accts Unapplied Balance Greater Than Zero Other
22 | TAAS 1013 Active MTG Accts Escrow Balance Greater Than Zero Other
23 | TAAS 1014 Approved Saving Acct Without Passbook and Restriction Other
24 | TAAS 1015 Active Dep Acct with Without Passbook and Parent Txn Other
25 | TAAS 1016 Active MTG Accts with Note Balance Greater Than Zero Other
26 | TAAS 1017 Active CK Account with 1000 bal and without restriction Other
27 | TAAS 113 Active Savings Account with 1000 balance without restrict Other

Field Listing:

Field

Description

Create SQL <sub
menu>

The Create SQL sub menu is used to access the Create SQL Statement screen
to add a new SQL Statement to the system and insert the information into the
SQLTEST EXTN table.

Edit SQL <sub
menu>

The Edit SQL sub menu is used to access the Edit SQL Statement screen to edit
a SQL Statement, update the system and insert the updated information into the
SQLTEST EXTN table.

Export <sub
menu>

When selected, the Generate Test Objects — SQL Export screen is displayed to
allow the Financial Institution the ability to create an export file of the SQL
Statements in the SQLTEST EXTN table to then import into another database.
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Field Description
Import <sub When selected, the Generate TestObjects — SQL Import screen is displayed to
menu> allow the Financial Institution the ability to import the SQL Statements into the

SQLTEST EXTN table from an export file that was created from the Generate
Test Objects application in another database.

Refresh <sub

When selected, the Generate Test Objects — SQL Test screenis refreshed, and

menu> all SQL Statements display on the screen that are in the SQLTEST EXTNtable.
Number Displays the system assigned number for the SQL Statement.

Name Displays the SQL Name of the SQL Statement.

Description Displays the SQL Description of the SQL Statement.

Category Displays the Category of the SQL Statement.

Close <button>

If the Close button is selected, the Generate Test Objects — SQL Test screenis
closed.

Delete <button>

If selected, the SQL Statement that is highlighted in the grid is deleted from the
SQLTEST EXTN table and removed from the display on the screen.

Once selected, the User is prompted with a confirmation message to allowto
complete the action or cancel and returnto the screen.

Navigation:

Services > System > Printing Operations > Generate Test Objects — SQL Test > Create/Edit
SQL Statement

Screen Appearance (Create/Edit SQL Statement):
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g Tickler ] Print Groups Table Maintenance ]
gl Create SQL Statement
7| Create SQL Statement
% 5QL Mumber I— Comments
g SaLName
- Description >o|
Category »I:Selec:l Category> j
=l
=
¥ Close " Clear i Review
Field Listing:
Field Description
SQL Number Disabled Field. System assigned number.
SQL Name User Defined. The name of the SQL Statement.
Description User Defined. The short description of the SQL Statement.
Category System Defined, Dropdown List of Values. The current valid values are:
Deposit Account
Loan Account
GL Account
Person
Organization
Channels
Other
Comments User Defined. Allows the User to enter a more detailed description of what the
SQL Statement represents.
SQL <box> This large white box is where the User will enter the SQL Statement.
Expand View Selecting the Expand View button makes the box larger to see the whole area
<button> without using a scroll bar.
Close <button> When selected, the screenis closed.
Close <radio When selected and the Process buttons are selected, the SQL'’s are
button> added/updated, and the screenwill close.
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Field Description
Review <radio When selected and the Process buttonis selected, the SQL’s are added/updated,
button> and the screen will remain open.

Process <button> | Once the Process button is selected, the SQL information is added/updated to the
SQLTEST EXTN table.

Navigation:
Services > Batch > View > Generate Test Objects — SQL Test > Export

Screen Appearance (Generate Test Objects — SQL Export):

Generate Test Objects - SQAL Export
Export File

File Path = | Browse |

Close Process

Field Listing:
Field Description
File Path Disabled. Once the file is selected, the file name and location display in the File

Path field.

Browse <button> | When selected, allows the User to browse to the location where the export file will
be saved and name the file.

Close <button> When selected, the screen is closed.

Process <button> | When selected, the exportfile is created and saved to the locationin the File Path
field. A message is displayed stating the number of SQL Statements are
exported.

Navigation:

Services > Batch > View > Generate Test Objects — SQL Test > Import

Screen Appearance (Generate Test Objects — SQL Import):

DNA Test Optimizer 24
08222019



DNA Test Optimizer Fiserv
Generate Test Objects - 3QL Import
Import File
File Path = | Browse |
Field Listing:
Field Description
File Path Disabled. Once the file is selected, the file name and location display in the File

Path field.

Browse <button>

When selected, allows the User to browse to the location where the export file
has been saved and displays the file name and location in the File Path field.

Close <button>

When selected, the screen is closed.

Process <button>

When selected, the import file is imported, and the SQL Statements added or
updated in the SQLTEST EXTN table. Amessage is displayed stating the
number of SQL Statements are added/updated. If the SQL Statement already
exists, the SQL Statement is updated. If the SQL Statement does not exist, it is
added. If there is a combination of existing and new SQL Statements, the
message lists the number that are added and the number that are updated.

Additional Requirements:
e DNA 4.4.1 or higher.

e In order to export/import the SQL Statements to/from multiple databases, the DNA
Test Optimizer application must be installed and authorized in all databases.

e Only the export files generated from the Generate Test Objects — SQL Test screen
can be used to import the SQL Statements into a database.

e If upgrading from the V1.0.0.0 version, existing SQL Statements will be assigned a
Category of ‘Other’ as part of the upgrade process. These SQL Statements may be
edited to assign a preferred category from the available list.

Configuration Checklist:

Item

Test
Environment

Production
Environment

Ensure the User has been assigned access to the Batch and
System Modules as appropriate.

Ensure the “SQL — SQL Maintenance” authorization item has
been assigned and appropriate permissions granted.
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Test Production
ltem Environment Environment

Ensure the SQL Statements have been created on the Generate
Test Object — SQL Test screen.

Revisions:
Date App Change
Version #

08/2019 |1.0.0.1 Application updated. Enhancements include the ability to assign
categories to help filter the SQL queries for User selection, screen-
level functionality to choose the maximum number of records
returned, and the ability to copy a record from the returned records
grid to then be pasted on another DNA screen (using the CTRL+C
and CTRL+V Windows functionality) to help facilitate testing ease.

02/2019 |1.0.0.0 Application Created
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